Nicolet iS50 FTIR User’s Booklet

.  How to Switch Between ATR and Transmission

If the ATR accessory is currently installed, and you want to do transmission IR
instead, please do the following steps:

1) Undo the nitrogen gas purge line by pressing down on the metal tab and
removing the purge line fitting:

Press Down
Here

.
-
—_—
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2) Next, push in the two extension tubes toward the accessory so that there is a
gap:

-

3) Then carefully lift up and out the ATR accessory:
: \

4) Insert the baseplate for Transmission IR. Note the alighment pins on the
front and the back:
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5) Insert the purge gas fitting by pushing it in until you hear it click:
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6) Close the door to the sample compartment:

o/

4_4
Please note: The sample compartment door must remain closed when

doing transmission IR. It should be opened only briefly to insert a sample,
and then closed again. After the cover has been open, you need to wait
several minutes for the nitrogen gas to purge out traces of carbon dioxide

and water vapor.
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II. How to Switch From Transmission to ATR

If the IR is setup for transmission, and you want to do ATR, perform the
following steps:

1) Open the sample door and remove the purge gas fitting by pressing down
on he metal tab:
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2) Lift up and out the transmission base plate:

3) Insert the ATR accessory and base plate. Note the two alighnment pins in
the front and the back:
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5) Push out both tube extensions so that there is no air gap:

T \

The cover remains open when the ATR accessory is installed. The carbon
dioxide and water vapor are purged out of the inside of the accessory.
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lll. Starting the Software and Running Your Samples

1) Start your session by launching the LSA Chemistry Recharge software. This
software keeps track of the amount of time that you are using the
instrument.

2) Type in your unigue name, your Pl’s uniqgue name and your shortcode in the
appropriate spaces. Then click the OK button.

H b
7, LSA Chemistry Recharge =

i Help

General Information

Instrumentation Mame | 1550

Computer Name CHEM-3411FTIR
LI-M Affiliztion @ Intemal ) Bdemal
IInigname

Accourt Information

Pl Unigname

Shortcode

http:/Asa umich edusait [ Cancel ] [ Ok ]

3) This will launch the Omnic software used to control the FTIR instrument.
4) Click on OK to select the default ATR setup.
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6) Click OK once the location test is complete.
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Sampling Location Test
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7) The instrument is now ready to begin the analysis. The experimental
parameters can be checked, or modified. Then, a background spectrum is
acquired, followed by acquisition of one or more sample spectra. One
background spectrum is sufficient for numerous sample spectra, as long as

the experimental parameters stay the same.
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l. Selecting experimental parameters:

1) Click on the Experimental Setup button in the upper left corner of the
screen.

B File Edit Collect View Process Analyze Report Window Help
Default (ATR correction) (MIRacle Diamond.exp)

N TR

ExplSet ColBkg Col Smp Open ackSpe FulSc CmnScl AutBsh AdvATR Subliact FindPks SelctAl  Clear Seach L

™ Click here to view the experimental parameters

804
701
601

50
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2) The default parameters for a standard characterization spectrum are 8
scans and a resolution of 4. The number of scans can be chosen by
entering the desired value. Resolution values are chosen from the drop

down menu.

' =)

Experiment Setup - c\my decuments\omnic\paramMIRacle Diamond.exp

Collect |Bench | Quality | Advanced | Diagnostic' Configure |
File Handling
M Save automatically V' Save interferograms

Estimated time for this collection: 00:00-11

Mo. of scans: |E |

B

Base name: | J
c:\my documentsiomniclautosave\0001.spa

Resolution: |4.

— Background Handling
Final format: |%Transmiﬁance j 1 Collect background before every sample
j C} Collect background after every sample

Correction: |NUHE
) Collect background after | 120 minutes

5 Automatic atmospheric suppression
) Use specified background file:

7 Preview data collection | |[,[-
10V S £ ‘

7 Use transmittance data during preview
M Use fixed Y-axis limits in collect window 1 Collect scans for the background

Min: Max: Experiment description:

FT-IR Solid sample

Experiment title:
Default (ATR correction)

[[ Heu [[Dpe‘n‘ ([SEWE‘ [Ea'uey [[ Du [[Canc‘elj
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3) Click on the Bench tab to view the range of wavenumbers covered by the
scan. These values can be change as necessary.

o -
Experiment Setup - c\my decuments\omnic\paramMIRacle Diamond.exp u

Collect Bench | Quality | Advanced | Diagnostic| Configure |

£| 5 Parameter Walue

© Win/iax © Peakio peak Sample compartment  Main ||
Detector OTGS KBr |<|
Beamsplitter KBr 5
Source IR |<|
Accessory Smart MIRacle -
Window Diamond -

Max range limit

Wavenumber range =

Min range limit

Gain:4 Autogain -
Optical velocity 0.4747 -
| | ' ' | ' ' o Aperture 87
2200 2000 Sample shuttle _
Attenuation Mone j
#’b@?‘ | <=
Bl e

| el S o=
| Esd) @b BB E-9) EoD E |
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ll.  Collecting a background spectrum:

1. Click on the Collect Background button in the upper left corner of the
screen to collect a background spectrum.

A OMNIC - Window1] l=lE
EJ File Edit Collect View Process Analyze Report Window Help _ & x
Expeviment:lDelaul( (ATR correction) (MIRacle Diamond.exp) j @ @ @SysmmS(ams
Re Takurad \ il A2 L

W, WA A | - . ‘ o @ tﬁ L[ e ) Ll (e | { ‘ f13hs h%

e R TR L oW iy | Q) iy | o

ExptSet ColBkg Col Smp Open Save Print Stack Spe  FullSc¢  CmnScl AutBsin AdvATR Subtract FindPks SelctAll  Clear Search  Lib Mgr PrevRpt AddNB  View NB

@G @

g

M Click here to collect a background spectrum

80-
704

60

s - - - - v - - - - v - - - - v - - - - T - - - - T - - - - v - - - - v
4000 3500 3000 2500 2000 1500 1000 500

2. You will then be prompted to confirm that you want to collect a
background spectrum. If you haven’t yet cleaned the ATR crystal, after
the previous user, now would be a good time. Click “OK” when ready.

-

Confirmation

Background
Please prepare to collect the background spectrum.

E'- IZJI{__J (L{.‘.ancel

3. After confirmation, the instrument begins to collect data. The steps
that the instrument takes can be viewed in the bottom left corner of
the screen. First, a couple of setup processes are completed, then a
countdown of the chosen number of scans begins (1 of 8, 2 of 8, etc.).
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When the collection is complete, the spectrum is displayed and you are
prompted to save the data to the currently opened window. If the data
are acceptable, click “Yes” to save the spectrum.

Confirmation

Data collection has stopped.

| f:\hew Collect Status

Add to Window1?

@%s ) (@ no ) (@Wore scans))

4. Below is a typical background spectrum.

= n
A OMNIC - Window1] - =l
[l File Edit Collect View Process Analyze Report Window Help HEE
Exilerilmm:lDefauh (ATR correction) (MIRacle Diamond.exp) j @ @\, @Sysmm&m
" ; = tokesad ol N L |
e < | B e B T OBE L W Gy | & | s W
ma e e e T R e B e Gy | & 3§ =
ExptSet ColBkg Col Smp Open Save Print Stack Spe FulSc  CmnScl AutBsin AdvATR Subtract FindPks SelctAll  Clear Seaich  LibMar PrevRpt  AddNB  View NB

(@ (@)[ Background, Tue Jan 16 15:45:39 2018 (GMT-05:00) ®

1 Background, Tue Jan 16 15:45:39 2018 (GMT-05:00)
22 - Background, Tue Jan 16 15:45:39 2018 (GMT-05:00)
{Tue Jan 16 15:57:45 2018 (GMT-05:00)
20 - Number of sample scans: 8
1 Number of background scans: 0
+Resolution: 4.000
18 1 Sample gain: 4.0
1 Optical velocity: 0.4747
16 - Aperture: 87.00
[ Detector: DTGS KBr

B
14:5

ooooo

‘S\nQIé‘B eam
N

. + . . . . ' . . . . . . . . . . . . ' . . . . .
3500 3000 2500 2000 1500 1000

Wavenumbers (cm-1)

v
4000

X:(3240.998) Y+(19.402)

| FW@;E@XI’ TR L —_—N g ‘

lll. Collecting a sample spectrum:

1. Before collecting a sample spectrum, you should first open a new display
window. Click on the Window menu and select “New Window.” You will
be prompted to name the window, but the default name provided is
generally fine, otherwise select your preferred title. Click “OK” to accept
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the title. The Window menu is also used to move between open

windows by clicking on the desired window name.

Mew Window

Enter a title far the window:

[pvindow2

@ ok @cance P

b

2. Click on the Collect Sample button in the upper left corner of the screen

to collect a sample spectrum.

A OMNIC - Window2] -

= [ [t |

[l File Edit Collect View Process Analyze Report Window Help

Experiment: |Defau1t (ATR correction) (MIRacle Diamond.exp)

j @ @ @Sysmm_&;ms

lakurid

L, Ly 5 ‘ - - | b Loy @ Eﬂ o RERERET e | | {ihs l% 1&
e e N S e TR L Y Gy | & | 8

ExptSet ColBkg Col Smp Open Save Print Stack Spe FullSc  CmnScl AutBsh AdvATR Subtiact FindPks SelctAl  Clear Search  Lib Mar PrevRpt AddNB ViewNB

@D@)|[1o o

O)

1007

™ Click here to collect a sample spectrum

90

804

701

60-

. v . . v . . v . . v . . v . . v
3000 2500 2000 1500 1000 500

3. You will then be prompted to provide a title to display on the sample
spectrum that is to be collected. Enter your desired title in the space
provided, and click “OK.” (Note: This is not the name of the file where
this data will be saved. For how to name your data file, please see the
section labeled “IV. Saving your data.”)
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Collect Sample

Enter the spectrum title:

@ ok @cance P

4. You will then be prompted to confirm that you want to collect a sample
spectrum. (Note: if your sample is air sensitive or otherwise unstable,
you can wait until this point to place your sample on the ATR crystal.)

If your sample is a liquid, no clamp pressure is needed.

If your sample is a solid, use the sample clamp. Turn the clamp knob
clockwise until you feel it slip. Click “OK” when you are ready to run the
sample.

-

Confirmation

2\ Sample
" Please prepare to collect the sample spectrum.

5. After confirmation, the instrument begins to collect data. The steps that
the instrument takes can be viewed in the bottom left corner of the
screen. First, a couple of setup processes are completed, then a
countdown of the chosen number of scans begins (1 of 8, 2 of 8, etc.).
When the collection is complete, the spectrum is displayed and you are
prompted to save the data to the currently opened window. If the data
are acceptable, click “Yes” to save the spectrum.
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Confirmation Li_&J

Data collection has stopped.

(& View Collect Status

-

Add to Window2?

@ %s ) (@ no ) (@Wore scans )
M Click here to accept the sample
spectrum and place it in the window

IV. Saving your data:

1) Click on the File menu and click on Save As. When the dialog box comes
up, Yyou can navigate to the folder where you want to store the data.

2) Click on the Create New Folder icon to initially create a folder for your
data or to create sub-folders within your main folder.

3) You should save your data in 2 formats: the default type called Spectra
(.SPA), and the text type called CSV (comma separated values). The .SPA
file can be opened by the Omnic software in order to display it at a later
date, whereas, the .CSV type can be opened by Excel, on your own
computer, in order to work up data without paying for your time. Both
files can be saved to a USB drive or emailed to yourself.
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Date modified Type

BB Nitrobenzyl Alcohol_mod_PJL_6-9-2017.5PA  6/9/20174:24 P OMNIC
BB Nitrobenzyl Alcohol_PIL_6-7-2017.5PA 6/7/2017 4:04 PM  OMNIC

itrobenzyl alcohol

Date modified
H Nitrobenzyl Alcohol_mod_PJL_6-9-2017.5PA  6/9/2017 4:24 PM
H Nitrobenzyl Alcohol_PJL_6-7-2017.5PA 6/7/2017 4:04 PM
Htraining sample.SPA 1/17/2018 3:55 PM

Spectra ~.5PA)
= Spectra (~.5PA)
- JCAMP-DX *.JDX%)

FCIR (*IRD}

SO

Fiaosnayt g gers s CMD < Select CSV text file type

GRAMS (~.SPC)
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V. Converting between % Transmittance and Absorbance

The default units of measurement for FTIR spectra are % Transmittance vs.
Wavenumber. If you desire the spectrum intensity to be displayed in
Absorbance units, click on the Process menu. The top 2 choices on this
menu will toggle between % Transmittance and Absorbance. Some data
work up processes (Subtraction, Baseline Correction and Library searches,
among others), require that the data be expressed in Absorbance units.

VI. Peak Labeling

1) The wavenumber at which peaks are observed can be automatically
labelled by clicking on the Find Peaks button on the Spectrum

Toolbar.

A OMNIC - Window2] — — e | B )
[ File Edit Collect View Process Analyze Report Window Help _&]x
Experiment: | Default (ATR correct tion) (MiRacle Diamond exp) | @ @ @Sys:emsgams

by, A s ‘ - o | Ll LA @ Eaﬂ mom M ‘ :& | hﬁ"‘ h‘:ﬁ '%

R ¥y v 0 3| & B Ly _wr ﬁs
ExptSet  ColBka  Col Smp UDen Save Print Stack Spe Ful S CmnScl AutBsln AdvATR Subtract FindPks  Selct All Clear ar Fres HDt AddNE  View NB
(@) ()| nitrabenzyl alcohol /I\ ®

alcoho
90 ] Wed Jan 17 15: 53242013
I Number of sample 5
{ Number of backgrou nd o

Click here to automatically labels peaks

_s mple gain: 4.0
rOphca\vE\m:\ty 0.4747
70,'Aperlure: 87.00

Detector: DTGS KBr
1Be amsth KBr

504 1 Source: IR
| C\my documentsiomniciSpectiaPaul Liraining sample CSV
501

. S S —
4000 3500 3000 2500 2000 1500 1000
Wavenumbers (em-1)

% Transmittance

X:(650.139) Y+(82 479)

| ®O@@®EYT T T N A &

2) When the Find Peaks button is clicked, a horizontal line appears on
the spectrum, indicating the threshold value for defining a peak.
Click with the tip of the cursor to reposition this threshold line.
When the desired position is determined, click on the Replace
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button in the upper right corner of the page to save the labeled
spectrum.

-
& OMNIC - [Find Peaks]

EEI=)

- - - - - N
Collect View Process Analyze Report Window Help

File Edit

Default (ATR carrection)

(MIRacle Diamand_exp) -

{
d

e [ TS0
Save Print Stack Spe Fi

ExptSet  ColBka

P v B L - N~~~ Y S s T 8

| & g

Col Smp Open

@ﬁpbiay |Rep|ace the original spectrum

Click here to save the labeled spectrum—

[ [=]x]

)

i Print i
i Y-Axis j

Sensitivity:
~|100

@ =0l ritobenzy alconal

| - [
Threshold:
72.819
V/ Annotate
results

VW\ /\ﬂﬂ /\W i

109181 =4

1480.70
1201.88
890.09

1038.11

801.04
669.58

1521.40
1345.71
- 72035

' . . !
1000 I

=
z4
8

: ' : : : : ' : : : : ' : : : : '
3500 3000 2500 2000
Wavenumbers (cm-1)
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3) The labels on some of the tallest peaks may not appear on the
screen. This can be rectified by clicking on the Full Screen button on
the toolbar.

p _ __ - —
A OMNIC - Window2] - -

ES File Edit Collect View Process Analyze Report Window Help
Default (ATR carrection) (MIRacle Diamand_exp) -

2 e (I | B o ia I < e B S O R IR,
ymd e e N S R e T iy
ExptSet  ColBka  Col Smp Open Save Prirt Stack Spe FulSc CmnScl AutBsih AdvATR Subtract FindPks  Selct Al Clear Seach  Lib Mar PrevFpt AddNB  View NB
(@) (@)| nitrobenzyi alcohol @
{nitrobenzyl al /I\
[ nitrobenzy! al
90 - Thu Jan 18 11 Cl' k h f F Il S
{ e o s ICK here 1or Full dcreen
1 Number of bac
80 - Resolution:  4.000
1Sample gain: 4.0
| Optical velocity: 0.4747

[ [=]x]

m_’Aperlure: 87.00
@ + Detector: DTGS KBr
2 [Beamsplitter: KBr
] S - IR
E ﬁﬂf ource
s |
)
:
AUj g
1 . s
BUi : §
5
Labels for these peaks are not seen. - )
- o
4u1uu ' ‘ ' ' 35‘un ' ' ‘ ' 3n|un ‘ ' ' ‘ zsluu ' ‘ ' ' znhn ' ' ‘ I 15|un ‘ ' ' ' m'ﬂn ' wP

Wavenumbers (em-1)

@Dl




4) Peak labels are not saved when spectra are saved. If you want a
hardcopy of the labeled spectrum, you can print it out on printer
next to the FTIR spectrometer. Alternately, you can copy and paste
the labeled spectrum into a Word, Excel or PowerPoint document, or
you can produce a report which will include the labeled spectrum, as
well as, a listing of the peak labels. This report can be generated by
going to the Report menu and clicking on Preview/Print Auto Report.
This report can be copied and pasted to a Word, Excel or PowerPoint
document and saved for future use.

VIl. Shutting down the software:

When you are finished using the instrument, close the software and
you will automatically be logged out of the Recharge software, and a
dialog window will confirm that point. You are then no longer paying
for time on the instrument.

VIII. Cleaning Sample Off of the ATR crystal:

The ATR assembly has some plastic parts that can be damaged by
aggressive solvents like acetone or methylene chloride. We prefer that
users use solvents like water, methanol or iso-propanol, if possible, to
clean off their samples after analysis. If more aggressive solvents are
required due to the nature of the sample, please try to restrict solvent
contact to the crystal and stainless steel portions of the ATR assembly.
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